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TuneBoy Live Maps 

User Guide 

Mitsubishi Software V4.0 
 
 

CAUTION 

 
 
All TuneBoy products are powerful tools that enable the user to change 

nearly all aspects of the program encoded into the motorcycle's ECU 
(Engine Control Unit). We cannot be held responsible for any direct or 

consequential damage to the motorcycle or any third party as a result of 
making any changes to the ECU programming.  To the fullest extent 

permitted by law, TuneBoy Pty Ltd will be under no liability to the 

Customer whatsoever for any injury, death, damage or direct or indirect 
or consequential loss (including without limitation, pure economic loss, 

loss of profits, loss of business, loss of use, loss of data, computer 
downtime, depletion of goodwill, business interruption, increased 

purchasing or servicing costs, loss of opportunity, loss of contracts and 
like loss) howsoever caused or arising out of or in connection with: 

 
• the sale or supply of any TuneBoy product,  

• any statement made or not made or advice given or not given by or 
on behalf of TuneBoy, including as to compliance with legislation or 

regulation, 
• use or misuse of any TuneBoy product, 

• Any use made or resale or on-supply of any TuneBoy product.  
 

This software and equipment is provided for use in closed course 

racing.  Use of this software and equipment to modify mapping may 
violate local laws and EPA regulations.  This is not for road use. 

 
The TuneBoy product reprograms the original ECU of the motorcycle. Any 

use of a TuneBoy product may invalidate a motorcycle's warranty. 
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INTRODUCTION  
 
There are two softwares from TuneBoy specifically for the Mitsubishi ECU of the 

Diavel, Panigale and MTS 1200. 

 
• The FlashMitsubishi software is used to load maps and trim files into the 

permanent flash memory of the ECU. 
• The TuneBoyTrim software is used to adjust the temporary copy of the 

trim tables.  This is also used for data-logging and processing data-log files. 

 

1. MAP FEATURES 
 
Several new features have been added to the Live TuneBoy maps for the Diavel, 

Panigale and MTS 1200.  The Live maps allow real-time tuning on a dyno. These 
include the following: 

 
1. Real-time adjustment of fuel and ignition trims while the motor is running, 

2. Auto-tuning in conjunction with Innovate LC-1 or LC-2 wideband O2 sensors 

(available from our website), 
3. Electronic cruise control, 

4. Quick shifter (strain gauge type) for clutchless up and down shifting. 
5. Shift light function, 

6. Map switching. The ECU can be loaded with up to 3 different trim maps. The 
rider can switch between trim files based on riding needs. 

 
The fuel and ignition trim maps have 24 RPM points and 12 throttle position or 

manifold pressure points. 
 

The cruise control uses a PID control loop to control the speed of the motorcycle. 
This is the same as most automotive cruise control systems and this can control 

speed to within 3kph over almost any road conditions. 
 

Quick Shifter function allows clutchless full throttle up-shifts and an auto blip 

function for clutchless down-shifts.  This requires a strain gauge quick shifter 
(available from our website). 

 
Shift light function allows you to connect a bright shift light to the O2 sensor plug.  

The ECU code has been changed so it will turn the light on at set points for each 
gear. 
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2. MAP TYPES 
 

 CAUTION 
   

  DIAVEL - 

For the Diavel it is very important that you use the correct map for 
your region. The Diavel has different maps for the USA, Japan and 

others (EU, AU, SA, NZ). 
 

Using the USA map for a bike in a different region will prevent some 
functions from working correctly.  

 

For example: the USA Diavel map will make the indicators activate 
instead of the brake light when the brakes are applied. This will also 

prevent the cruise control from turning off when brakes are applied.  
For the Diavel Strada you should use the EU mapping. Make sure you 

check that the indicators and brake lights work correctly after the 
tune is installed. 

 

DIAVEL MY 2014 Dual Spark Models - 

The 2014 Dual Spark Diavel also has different maps to the 2011-2014 
Diavel and Diavel Strada.   Care must be taken to use the correct 

map for your model. 
 

MULTISTRADA 1200 MY 2013 and 2014 Dual Spark Models - 

The 2013 Multistrada also has different maps to the 2012-2012 
Multistrada.   Care must be taken to use the correct map for your 

model. 

 
 

2.1 Cruise-ONLY Maps: 
• This map type simply adds the electronic cruise control without changing 

any other aspect of the mapping.  
• This map does not turn off the O2 sensors on the bike.  

• This map type does not support the speed ‘nudge up/down’ buttons as 
these require use of the O2 sensor plug. 

• This map type does not support the Quick Shifter as this requires use of the 
O2 sensor plug. 

• This map type does not support the Shift Light function as this requires use 
of the O2 sensor plug. 

• You cannot apply any trim tables to this type of map.  
 

These maps have a name ending with CruiseOnly_V4_Tune.dat. 

 
 

2.2 Tuning Maps: 
• Tuning maps allow real time adjustments to be made for fuel and ignition.  

• Trim maps can be applied to this type of map. 
• The tuning map supports the Quick Shifter and Shift light.  
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• Tuning maps do not have cruise control. 
 

These maps have a name ending in Tuning_V4_MSTune.dat.  
 

2.3 Cruise Control and Tuning Map: 
• These maps allow real-time (Live) tuning of the fuel and ignition maps.  

• You can load trim maps into this type of map.  
• This map type can do everything the tuning map can do with the addition of 

the Cruise Control function 
 

These maps have a name ending with CruiseAndTuning_V4_MSTune.dat.   

 
2.4 Standard Maps 

• This is a completely standard map.  No modifications have been made to 
this map.   

• This map is to return your bike to a completely standard state of tune. 
 

These maps have a name ending with STD_Tune.dat. 
 

N.B. Some maps may also have a country designation in their name. 
EU – Europe/Australia/New Zealand/South Africa 

JP – Japan 
US – USA (Diavel Only) 

 
The difference between the EU and US map is the way the rear indicators work. 

On the US model Diavel the brake light is also used as the indicator, the left side 

of the brake light blinks for left turn and the right side blinks for right turn. 
On the EU model Diavel the rear direction indicator uses an amber light for each 

side. 
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3. SET-UP 
The first step is to install the software on your PC. If the setup program does not 
start when you put the CD in your CD drive you should open Windows file 

explorer and run the setup.exe program from the root of the CD drive. 

We recommend accepting the default settings as these will help with any problem 
solving if you have to contact support. 

 
Once the TuneBoy software is installed you should run the LogWorks3Setup.exe 

from the root of the CD. This will install the drivers for the WB-01 device if you 
need to connect this to the PC using a USB cable. 

 
If you are only connecting to the PC using WiFi this step is not required.  However, 

when data-logging on the Diavel it is recommended that you 
always connect using WiFi. Connecting the USB cable between the PC and the 

bike allows the electrical noise from the bike to upset the USB port.  Flashing the 
ECU should be done via USB as this will be faster than WiFi. This is because the 

WiFi introduces delays that can cause slow the flash process down. 
 

Windows 8.1 
With Windows 8.1 Microsoft removed ad hoc WiFi network support from the 
networks list (right side of task bar). This makes it hard to connect wirelessly to 

the WB-01. 
 

To help with this we have included a program on the CD called WB01_Find.  
 

Connect the WB-01 to the PC using USB. Make sure the MTS light is flashing and 

the power light is on.  Run the WB01_Find program and click “Search for WB-01”. 
You should see a message saying the TUNEBOY device has been found then 

another message saying the network profile has been created. 
 

Once this has been completed the flash and trim programs will be able to connect 
to the WB-01. 

 
 

 
4. INSTALLING THE FIRST MAP  
 

4.1 Getting Started: 
The first time you load a map into your bike you will have to do several steps. 
These require a connection to the internet and the user ID and password you 

received when you purchased the software. 
 

The User ID and password are required to unlock the ECU. This will have been 
emailed to you when you purchased your Kit. 

 
1. Connect the WB-01 to the diagnostic connector on your motorcycle. This is 

 located under the seat. 
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2. Connect the WiFi on your PC to the WB-01 or plug the USB cable between 
 the WB-01 and PC.  If you are using the USB cable you should have 

 installed the drivers for the WB-01 as part of the LogWorks install.  
 

When connecting via WiFi, you will see a WiFi network with TUNEBOY_nnnn 
where nnnn is a number unique to your WB-01. 

 
If you are using Windows 8.1 you don’t need to connect the WiFi if you have run 

the WB01_Find. 
 

3. Turn the motorcycle ignition ON and start the FlashMitsubishi program on 

 your PC. 
 

You should see the following window displayed: 
 

 
 
 

4. Click the “Select Tune File” button to select an initial tune file to load into 

the ECU.  
 

 
The following screen is shown to select the tune file: 
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Once you have selected a tune file the following screen is displayed: 

 

 
 
 

5. Click the “Prepare ECU” button and the program will first erase the flash 
 memory in the ECU then start a download to the ECU. The message 

 “Erasing Flash” will be shown and the progress bar will move from right to 
 left as is shown in the next screen shot: 
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Note: If the message still has “Idle” displayed you should close the program and 

repeat this step. 

 
 

Once the flash memory is erased the screen will show the percentage data 
transfer and the progress bar will move from left to right as is shown in the 

following screen shot: 
 

  
 
 

If the “percentage complete” stops incrementing before you get to 100 % you 

should repeat the process. If this happens more than once you should repeat this 
step using the USB cable instead of a WiFi connection to the WB-01. 

 
 

Once the download is complete the following message will be displayed: 
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6. At this point you click “OK” and then click “Exit” on the main screen. 
 

7. Start the FlashMitsubishi program again. 

 
A pop-up screen will now be displayed asking you to turn the bike off and on 

again. 
 

 
 

8. Click “OK” and then click “Exit” to close the FlashMitsubishi program. 
 

9. Turn the motorcycle off and on again, waiting 30 seconds between 
 turning the motorcycle off and turning it on again. 

 
10. Start the FlashMitsubishi program again.  

 
The following screen should be displayed. The ECU serial number displayed will be 

unique to your motorcycle: 

 

 
 
11. Click the “Cancel” button and exit the program. 

 
12. Turn the motorcycle off and disconnect the WB-01 from the motorcycle.  
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Make sure your PC has connection to the internet.  The next step does not require 
a connection to the motorcycle. 

 
14. Start the “FlashMitsubishi” program again. If the pop-up screen appears 

 with the message “Do you want to connect WiFi to TuneBoy WB-01” you 
 should click the No button. Now the “Key Generation” pop-up screen shown 

 above will be displayed again. 
 

15. Enter your user ID and password and click the “Generate key” button. 
 

The user ID should be the email address used when you purchased the product. 

The password will have been sent to you in an email. 
 

Note - Key Types 
Make sure you have the correct type of key selected.  By default this screen has 

the full Cruise Control and Tuning key selected.  If you have purchased a tuning 
key, cruise only, or O2 sensor disable key you should change the selection to 

reflect the type of key that you have purchased. 

 
The option for different key types is intended for dyno shops and dealers. If you 

are a customer working on your own bike you will most likely have the Tuning 
and Cruise key. 

 
 

You will now get a pop-up message as per the screen shot below: 
 

 
16. Take note of the key number that is 

 displayed. You will need this if you 
 need to install the software on 

 another PC or if you have to re-install 
 the software. 

 

17. Stop the FlashMitsubishi program and 
 reconnect the WB-01 to the motorcycle 

 and to the PC. 
 

18. Turn the motorcycle on and start the FlashMitsubishi program again. This 
 time you will see a serial number but you will not be prompted for a key. 

 This shows that the key has been added to the registry on your PC.  
 

 
The following screen will be displayed: 
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19. Click “Select Tune File” and select the tune file you want to load into the 

 ECU. 

 
• If you have an O2 Disable key you can only download maps to disable the 

O2 sensor function.  
• If you have a Cruise Control only key you can only download the 

CruiseOnly maps.  
• If you have a Tuning key you can download the O2 disable maps and the 

Tuning maps.  
• If you have a key for the Cruise Control and Tuning key you can 

download any tune file. 
 

 
After you have selected a tune file the following screen will be displayed: 
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If you have been provided with a trim file you can apply the trim file to the tune 
by clicking the “Apply trim table to tune”. This will display a file open box.  

 
20. Select the trim file you wish to load. After you have selected a trim file the 

button text will change to “Apply second trim table to tune”. If you want to 
apply multiple trim maps to the ECU you can repeat the trim selection up to 

two more times. 

 
 
21. Once you have selected the third be greyed out as shown in the following 

screen shot: 
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Passwords: 
The password field is used to protect against unauthorized access to your bike by 

another TuneBoy user should you leave the WB-01 on the bike while riding. This 

is not your User ID’s password that is linked to your key.  You can enter any 
number from 0 to 65535 as a password. Please make note of your chosen 

password for future reference: 
 

My Chosen Password Is: __________________________ 
 

22. Once you enter a password, click the “Flash map into ECU” button. This will 
again erase the flash memory in the ECU and program the completed map into 

the ECU.  
 

The following screen shot shows the download in progress:  
 

 
 

 
After the “Download Complete” message is displayed you are ready to ride the 

motorcycle or tune using the TuneBoyTrim software. 

 

4.2 Returning the Bike to Standard: 
The TuneBoy CD contains the factory standard maps for EU, US and Japanese 
model bikes. These maps can only be loaded into the ECU once a TuneBoy map 

has been loaded and the correct key entered (steps shown above). 

 
When you start the FlashMitsubishi program you will only be able to open the 

standard tune files if the “ECU Serial Number” field has a valid serial number.  If 
this field does not show a serial number you should stop the flash program, wait 

30 seconds then start it again. 
 

Once you select a standard tune file the “Flash map info ECU” button will change 
to “Return ECU to standard map” (see screen shot below). 
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Returning the ECU to standard mapping will not prevent you from reloading one 

of the TuneBoy tune files at a later date.  Many customers like to return the ECU 
to a standard state when they take the bike in for service work.  Returning the 

ECU to standard will require all standard parts to be fitted again.  For example, 
the exhaust flap and O2 sensors will need to be connected otherwise you will 

have errors on the dash. 
 

These maps have a name ending with STD_Tune.dat. 

 
N.B. Once you have returned the ECU to a standard tune, the serial number will 
no longer be displayed in the FlashMitsubishi program and the TuneBoyTrim 
program will not be able to read the map from the ECU.   

 
Simply use the FlashMitsubishi program to load a TuneBoy tune and the TuneBoy 

features will work again.  You will not need to get a new key. 
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5. SET-UP OF THE INNOVATE LC-2 WIDEBAND 
O2 CONTROLLER 
 

CAUTION 
The oxygen sensor when used in this device gets very hot in 

operation. Do not touch the hot sensor. Do not let a hot sensor 
touch a combustible surface. Do not use the sensor with or 

near flammable liquids or gases. Failure to heed these 
warnings may result in severe burns, explosions or fires. When 

installed in the exhaust, the oxygen sensor MUST be connected 
and operating with the LC-2 whenever the vehicle is running. 

An un-powered oxygen sensor will be quickly damaged when 
exposed to hot exhaust gases. 

 
With the addition of an Innovate LC-2 wideband O2 

controller you can make use of the new real-time 
mapping to allow auto-tuning of the fuel map. 

 

The LC-2 no longer comes with the cable to connect to 
the WB-01 WiFi box; this part must be purchased 

separately if you need it.  We recommend connecting 
directly to the O2 sensor plug on the motorcycle.  

 
If you purchase the LC-2 as part of a kit we will put 

the correct plug on the LC-2 to directly plug into the 
wiring loom. Our LC-2 Kit (P/N 3884) is exclusive to 

TuneBoy and comes with a 3ft Sensor cable for 
convenience. 

 
When the LC-2 is connected in this way it is powered 

on with the ignition. This is important to remember 
and for the protection of the O2 sensor you should 

avoid leaving the ignition on for long periods without the motor running. The O2 

sensor can be damaged if it is exposed to the moisture that can build up in the 
exhaust system as it cools down. The moisture is not a problem if the sensor is 

cold when the motor is started. 
 

You can connect any wide band O2 controller to the O2 sensor plugs on the bike. 
The only requirement is that the output of the wide band controller is 0 volts for 

10/1 AF Ratio and 5 volts for 20/1 AF Ratio.  If you are using a different wide 
band O2 sensor you must make sure you select “Generic 0-5v” in the 

TuneBoyTrim target screen, the default is the Innovate A/F range. 
 

 
1. Start the TuneBoyTrim program.   

 
When this program starts you will see a screen similar to the image below: 
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Note: Message at the bottom of the screen “Reading map from ECU”. 

 
2. If you have entered a password on the FlashMitsubishi program you will be 

 prompted for this password again when you start the TuneBoyTrim program. 
 This password is your chosen number between 0 to 65535. You will only be 

 asked for this once. The number will be remembered the next time you 
 start the TuneBoyTrim program. (for passwords see page 14) 

 

3. Once the program has read the trim map from the ECU you will see a 
 message “Map Read Complete” and the message will change to “Get 

 running data”, or a pop-up window asking if you want to replace the data in 
 the ECU with the data from the PC.   

 
 

If you click “NO”, the data from the ECU will replace the data in the 
TuneBoyTrim program. 

 
If you click “YES”, the data from the TuneBoyTrim program will replace 

the data in the ECU. 
 

Example: 
If you are working on the dyno and need to stop for a break, you should go to the 

“File” menu and select “Save Trim File”, enter a file name and save the file. 

 
When you want to start working on the dyno again you should do the following: 

 
• Start the TuneBoyTrim program and select “Open Trim File” from the “File” 

menu. This will open the file and display the trim values as they where 
when you saved the file. 
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• Turn the ignition on and the TuneBoyTrim program will ask if you want to 
replace the data.  

• Click “Yes” and the program will update the data in the ECU with the data 
saved in the trim file. 

•  
You can now resume the tuning work without needing the reflash the ECU. 

 
Note: The first time you connect to the ECU with the TuneBoyTrim program you 

should click “No” (if asked) to make sure the data you start working with is the 
same as the data in the ECU. 

 

 
6. TABLES IN TUNEBOYTRIM PROGRAM 
 
The tables available in the TuneBoyTrim program are: 

• Fuel TP Trim (F) 
• Fuel TP Trim (R) 

• Fuel MAP Trim (F) 
• Fuel MAP Trim (R) 

• Ign. Trim (F) 
• Ign. Trim (R) 

• A/F TP (F) 
• A/F TP (R) 

• A/F MAP (F) 

• A/F MAP (R) 
• A/F Target TP 

• A/F Target MAP 
• Blip H 

• Blip Length 
• TPH H 

• TPH L 
 

6.1 Fuel TP Trim and Fuel MAP Trim (Front) and (Rear) 
These tables contain the fuel trim values for front and rear cylinders. The TP 
tables are used when the ECU is mapping based on throttle position. The MAP 

tables are used when the ECU is mapping based on manifold pressure. “F” 
indicates the table is for the Front cylinder.  “R” indicates the table is for the Rear 

cylinder.  
 

To change the values in the cells select the area you want to change and use the 
PageUp and PageDown keys on the keyboard.  

 
The values in the table are percentage adjustments. These values are applied to 

the main fuel tables once the ECU has looked up the main fuel table. 
 

Example,  
+5.0% in a trim table will increase the fuel delivery by 5%,  

-5.0% in a trim table will decrease the fuel delivery by 5%. 
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Any adjustments to these tables will be sent to the ECU within a second and the 
result should be seen in the air fuel ratio.  

 
You should not need to adjust the MAP tables as the base program in the ECU has 

been changed to restrict the manifold pressure mapping to the area from 0 to 
2.5% throttle up to 5000 RPM.  

 
All mapping on the dyno should be done with the TP tables. 

 
 

6.2 Ignition Trim, F/R 
These tables are for adjusting the ignition advance for the front and rear cylinders 
Values in these tables are in degrees of ignition and are added or subtracted from 

the main ignition map values used by the ECU. 
 

To change the values select the area you want to change and use the Page Up 
(PgUp) and Page Down (PgDn) keys on the keyboard.  

 

Changes to these ignition trim tables should only be done on a dyno that can 
show horsepower while holding a fixed RPM. 

 
If you are on a dyno that shows horsepower while holding RPM you can adjust the 

ignition trim while watching the horsepower reading on the dyno. If you add 
ignition advance and the horsepower increases, this is good.  Once you get to the 

point where adding ignition does not increase horsepower you should back off the 
ignition to the point that made the most horsepower with the lowest ignition 

value. The reason for this is that the power will plateau for a number of degree’s 
(up to 10 degree’s) before the ignition advance starts to cause detonation and a 

reduction in power. 
 

6.3 A/F TP (F) and (R)  
 
If you have an Innovate LC-2 wideband O2 controller connected this table will be 

filled in with the average A/F (Air/Fuel) ratio from the LC-2 when the throttle 

position and RPM are within +/- 25% of the exact cell location. 
 

For example, if the LC-2 A/F ratio is 13.5/1, the RPM is at 2600 RPM and throttle 
position is at 45%, the value 13.5 would show in the 40% throttle 2500 RPM map 

location. 
 

The TuneBoyTrim program uses these measured values in conjunction with the 
target A/F values to work out the amount of trim required to correct the fuel map. 

 

N.B. If you have the LC-2 connected to O2 sensor plug on the motorcycle it is 
important that you do not have the QuickShifter or Nudge buttons selected, this 

makes sure the output of the LC-2 is not mistaken for Nudge button or 
QuickShifter input. 
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6.4 A/F MAP (F) and (R) 
If you have an Innovate LC-2 wideband O2 controller connected this table will be 

filled in with the average A/F (Air/Fuel) ratio from the LC-2 when the manifold 

pressure and RPM are within +/- 25% of the exact cell location. 
 

For example, if the LC-2 A/F ratio is 13.5/1, the RPM is at 2600 RPM and manifold 
pressure position is at 488 millibars, the value 13.5 would show in the 488 

millibar row 2500 RPM map location. 
 

The TuneBoyTrim program uses these measured values in conjunction with the 
target A/F values to work out the amount of trim required to correct the fuel map. 

 

N.B. If you have the LC-2 connected to O2 sensor plug on the motorcycle it is 
important that you do not have the QuickShifter or Nudge buttons selected, this 

makes sure the output of the LC-2 is not mistaken for Nudge button or 
QuickShifter input. 

 

6.5 A/F Target (TP)  
This table contains the target A/F ratio you would like for each point in the map. 

You can set this so that low throttle positions have 13.5/1 and high throttle 
positions have 12.9/1 as shown in the following screen shot: 

 

 
 
 

When the TuneBoyTrim programs Roll-On feature is used these values will be 
compared to the measured values from the “A/F TP (F)” and “A/F TP (R )” tables  

to work out how much to change the trim values by in order to try and bring the 
measured A/F values in line with the target A/F value. 
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6.6 Blip H 
This table contains the target throttle percentage to be used for the down-shift 

auto-blip.  This table is only used if you have the strain-gauge Quick-Shifter fitted. 

 
The table contains a row for each gear and 24 RPM points. 

 
When the strain-gauge shifter reaches the trigger point for the down-shift blip the 

ECU uses the value from this table to know how far the throttle needs to open for 
the current gear and RPM. 

 
Values in the table are throttle percentage. 

 
Below is a screen shot of this table: 

 

 
 

You can see that the throttle opening gets higher as the RPM increases. 

 
The values in the row for first gear are used for the blip function on the iPhone 

and Android apps. 
 

If you increase the values in the Blip H table you will feel more of a push forward 
as you down-shift. If you feel that the down-shift has too much of a surge 

forward you should reduce the value at the point that you feel this is happening. 
 

 

6.7 Blip Len 
This table contains the time, in milliseconds, that the down-shift throttle blip will 

last.  This table is only used if you have the strain-gauge quick-shifter fitted. 
 

The table contains a row for each gear and 24 RPM points. 
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When the strain-gauge shifter reaches the trigger point for the down-shift blip the 
ECU uses the value from this table to know how long to hold the throttle at the 

value from the Blip H table for the current gear and RPM. 
 

Below is a screen shot of this table: 
 

 
 

Increasing the values in this table will have the same effect as increasing the 
values in the Blip H table.  We suggest increasing the values in this table before 

you increase the values in the Blip H table. 

 
If you want to reduce the blip effect it is best to reduce the Blip H table value.  

This is recommended this is because the throttle blip is a mechanical action and it 
takes time for the throttle to react. 

If you decrease the Blip Len value you may be reducing the height of the blip by 
not allowing enough time for the throttle to reach the desired blip height. 

 

6.8 TPH H  
This table contains the value to use as the lowest throttle value after a down-shift 

has completed. The purpose of this table is to reduce the engine brake effect 
when the throttle closes after the down shift. 

 
The values in this table are throttle percentage. 

 
An increase in the values in this table will make the bike feel like it wants to roll 

forward after the down shift. 
 

Below is a screen shot of this table: 
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The best way to understand these values is to make some changes and ride the 

bike.  You can use the trim map switch feature of the TuneBoy maps to try 
different values. 

 
Example: 

1. Select this entire table and increase the values to 5.0.  This will mean the 
throttle stays at 5% for a short period after the down-shift. 

 

2. Save the trim file with a new name. 
 

3. Use the FlashMitsubishi to load the original trim file and the modified trim 
file. Ride the bike to get a feel for the down-shift action. 

 
4. Pull to the side of the road and turn the ignition off and on (don’t start 

motor). 
 

5. Turn the throttle fully open and pull the clutch in, then release the clutch.  
This is the signal to the ECU that you want to switch to the next trim file. 

 
6. The rev counter will go to 5000, 7500 or 10000 to indicate which trim map 

it has changed to (trim map 1, 2 or 3). 
 

7. Start the motor and ride the bike to feel the difference in the down-shift 

action. 
 

8. Using this method is the best way to get an understanding of what to 
expect from a change to these tables. 
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6.9 TPH Len  
This table contains the time, in milliseconds, that the post-blip low throttle should 

stay in effect. The values in this table work with the values in the TPH H table in 

the same way that the Blip Len values work with the Blip H values. 
 

The maximum time you can set for any value in this table is 200 milliseconds 
 

Below is a screen shot of this table: 
 

 



 25 

7. USING THE TUNEBOYTRIM PROGRAM FOR AUTO-

TUNING 
 
We recommend this be used on an eddy-current brake dynamometer for best 

results. Some common dyno’s are not very good at steady state mapping because 
they are very poor at holding a set RPM. Dyno’s like the Dyno Dynamics, Factory 

Pro, Mainline, Mustang, Superflow etc are much easier to use for this process. 
 

Using the Auto-Tune feature requires use of an Innovate LC-2 or other wideband 
O2 controller. 

 

When the auto-tune feature is turned on the TuneBoyTrim will start to make 
adjustments to the trim values after a set number of A/F samples have been read. 

This option is best used at lower throttle points, up to about 20% throttle. 
To use this option you select the “Auto-Tune” mode then set the dyno to hold a 

fixed RPM. Apply throttle to hold the throttle position within the target zone 
(green dot on target screen). 

 
If you click the mouse in any of the tables you can use the ‘A’ key on the 

keyboard to turn the auto tune on and off. This allows you to hold a point and 
press ‘A’ to turn the feature on then ‘A’ again to turn the feature off. 

Working in this on/off way allows you to watch the A/F after a change as it 
sometimes takes a few seconds for the reading to react to the changes. 

 
It is also good to toggle auto tune off as you move the throttle to the next 

throttle point. This makes sure that any throttle enrichment is ignored. 

Throttle enrichment is extra fuel that the ECU adds when the throttle is moved; 
this will make the A/F ratio appear richer while the throttle is moved. 

 
Once the throttle has been within the target for 10 samples the TuneBoyTrim 

program will calculate the average A/F ratio from these samples and update the 
trim table to try and bring the A/F value in line with the target value for this map 

point. 
 

After the correction is sent to the ECU the program will start to sample again until 
it has 10 samples then it will make another adjustment. 

This process will repeat until you move the throttle out of the target zone or 
toggle the auto tune off by pressing the ‘A’ key. 

 
Tuning this way makes it easy to adjust the steady-state throttle values (low 

throttle values are considered steady-state values). 

 
In this mode you should avoid sudden throttle changes as these unexpected 

changes will trigger the ECU’s throttle enrichment (throttle pump function) and 
this will make the A/F values appear rich. The auto-tune mode should only be 

used on the dyno as the throttle can be controlled on the dyno without sudden 
changes. 
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7.1 Target Screen 
The target screen can be displayed by selecting the “View” menu and selecting 

“Target Screen” from the drop down menu. You can also display the target screen 

by clicking anywhere in one of the tables and hitting the T key on the keyboard.   
 

The target screen is also displayed when you select “Roll-On Mode”. 
 

The target screen: 
 

 
 

You can use the mouse to drag this screen off to the side if you need to see the 
tables.  You can also use the T key to toggle the target screen off and on (Once 

you click back in to one of the tables). 
 

The yellow dot in the target shows how close you are to the most relevant cell in 
the map. 

 
The drop down box marked “O2 sensor type” allows you to select between the 

default 0 to 5 volt output for the LC-1 wideband, or a generic 0 to 5 volt wide 

band. 
The LC-1 wideband by default has 0 volt = 7.35/1 to 5volts = 22.39/1. 

Generic 0-5 volt has 0 volt = 10/1 to 5 volts = 20/1. 
Make sure this value is correctly set or you’re A/F values will be incorrect 

 
If you do not have two wide band O2 sensors connected you can remove the tick 

from the A/F sensor value that should be ignored. e.g. A/F Front or A/F rear tick 
boxes in the target screen. This allows you to use the auto-tune mode with a 

single sensor. You can run once with the sensor in the front cylinder, then once 
with the sensor in the rear cylinder. 

   
For example, if the RPM was 2600 and throttle was at 11% the yellow dot will be 

slightly above the horizontal line and to the right of the vertical line. 
If the RPM was exactly 2500 and throttle position was exactly 10% the yellow dot 

would be in the middle of the target. 

 
The target screen always shows the location relative to the closest cell in the map. 

As revs increase the yellow dot will move from left to right, once it goes off the 
target on the right side it will reappear on the left side as it is now showing 

position relative to the next RPM point in the map. 
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The inner green square is +/- 25% of a map point.  A/F values are only recorded 

and used when the yellow square is within this green box. The size of the target 
zone can be adjusted if required in the Process Log File in the TuneBoyTrim 

program. 
 

The target screen will display the current A/F ratio from the Innovate LC-2 
wideband O2 sensor for the front and rear cylinders.  These figures will be 

displayed in colour based on the corresponding value from the Air Fuel Target 
screen. (See following image.) 

 

• If the current A/F is within 0.2 of the target the figures will be shown in 
green. 

• If the current A/F is more than 0.2 over the target the figures will be shown 
in red to indicate a lean situation. 

• If the current A/F is more than 0.2 under the target the figures will be 
shown in blue to indicate a rich situation. 

 
Note: 

On the Diavel the rear O2 sensor is under the tank, this makes it hard to access. 
To solve this problem we have added a feature to duplicate the front A/F value on 

the rear A/F display. 
If you have the O2 sensor in the rear exhaust and the plug connected to the front 

O2 plug you press ctrl O and the front A/F reading will appear in A/F Rear, now 
remove the tick from the front A/F display and the readings will only appear in 

the rear A/F table. 

This allows tuning of the rear cylinder without needing to remove the fuel tank to 
access the rear O2 sensor plug. 

 
 

7.2 Engine Temperature 
The engine temperature is displayed to make sure the motor does not overheat 

while tuning the bike.  Note that tuning when the motor is cold will skew the 

results. 
 

• Blue on the engine temp indicates a cold motor, below 75o C (176o F). 
Green indicates the motor is between 75 o C and 100o C (167o F and 212o F).  

(The range can be adjusted if required in the Process Log File in the 
TuneBoy Trim program.  See page 25.)  

 
• Red indicates the motor is over 100o C (212o F) and you should let it cool 

down before making any mapping changes. 

 
7.3 Using the Auto-Tune Feature 
To start the Auto-Tuning feature click the A key on the keyboard or select “Auto 

Tune” from the Options menu.  A marker will appear in the “Auto Tune Enabled” 
(radio button) on bottom right of the target screen. 

 
When Auto-Tuning is enabled the TuneBoyTrim program will make adjustments to 

the map whenever it been within the green target zone for the stable sample 
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count (this is 20 by default but can be changed on the “Process Log Screen”), 
This count is used to make sure any throttle enrichment has decayed to 0 before 

the software tries to make adjustments. Once the stable count has been reached 
the software will collect 10 samples for the cell in the map.  Once it has collected 

the 10th sample with a yellow dot still within the green target box, the program 
will compare the average A/F value from these 10 samples against the target A/F 

from the target table. It will calculate the change required to bring the A/F into 
line with the target.  This change is sent to the ECU and the sample count is set 

to zero for that map location.  
 

The program ignores the next 5 samples for this point to allow time for the 

change to be sent and a resulting change in the A/F.  
 

If the map point has not changed the software will repeat the process. 
 

If the map point has not changed the software will not need to wait for the stable 
sample count; it will only need to wait for the stable sample count if the throttle 

point has changed. 
   

If you have the bike on a dyno that can hold the RPM without too much 
fluctuation you simply need to turn the throttle while watching the yellow dot in 

the target.  Once the yellow dot is within the green square hold the throttle and 
watch the A/F display change until it is green.  Now turn the throttle to the next 

throttle point and the process will repeat. 
 

This type of tuning should only be done for the lower throttle points, up to the 

20% throttle point.  Auto-tuning tuning does not work on the 0% throttle row.  
This must be adjusted manually. 

 
To tune the points above 20% throttle you should use the following method: 

1. Set the dyno to hold at around 2500 RPM; 
2. Set the ramp rate on the dyno to a slow climb.  On a DynoDynamics dyno 

we set this to 6 kph/sec to 10 kph/sec, depending on the throttle amount.  
On a DynoJet® dyno you will need to set the dyno to hold some load once 

you start the run; 
3. With the dyno holding the bike at 2500 RPM turn the throttle to the point 

you want to tune; 
4. Once you have the throttle stable between the lower and upper green lines 

in the target screen you should click the button to allow the dyno run to 
start. 

 

As the ECU runs through the map points the average A/F value will be stored.  
Provided the ramp rate is slow enough the TuneBoyTrim program will collect 

enough samples to adjust the map. 
 

If the “Roll On Mode” has been selected the trim software will calculate the 
required changes as soon as the throttle position drops out of the target zone. 

These changes will be sent to the ECU and the text colour on the A/F screen will 
turn grey. 
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The screen shot below shows the A/F table after running the bike up through the 
revs at the end of a tuning session: 

 

 
 
In the image above you can see that most points in the map are green. The text 

colour is grey to indicate that changes have been made, based on these readings. 
The few points that still show red and blue have had a correction made based on 

these values. If the bike was run through these points again the values should be 

on target. In effect this screen shot shows the second to last state of tune. It is 
not necessary to run through again as we can see the A/F values are very good. 

 
Each cell in the Air Fuel Ratio table is coloured to indicate if the point in the map 

is rich (blue), lean (red), or close to the target value (green).  The further from 
the target the darker the colour. 

 
Any point that is obviously incorrect can be cleared/zeroed by clicking on that 

point in the map and hitting the Z key on the keyboard.   
Hitting the Z key moves the value back one level in the A/F screen and moves 0 

into the current value. You may need to hit the Z key twice to actually see 0 in all 
locations in the table. 

 
To make the Air Fuel numbers easier to interpret we have added a graph view for 

the A/F values.  Click the G key on the keyboard to display the A/F Graph screen.   

See screen shot next page: 
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• The green dashed line is the target Air/Fuel line, 
• The solid yellow line is the measured Air/Fuel ratio for the front cylinder, 

• The solid light blue line is the measured Air/Fuel ratio for the rear cylinder, 
• The blue line shows the current position on the line (RPM point). 

 
Only one line of the A/F table is shown at a time.  Use the up and down arrow 

keys on your keyboard to move through the different throttle positions. 

 
You can use the mouse to drag this screen off to the side if you need to see the 

tables.   
 

When you use the Roll-On Mode the graph screen will update after each runs pass 
through the revs. This helps the dyno operator see if the A/F values are moving in 

the correct direction. 
 

CAUTION 
N.B If you change the values in the Fuel Trim table the 

corresponding point in the Air Fuel Ratio table will be cleared.  
This makes the text colour grey to indicate that the value 

cannot be used to make corrections. 
This is done to ensure you do not manually adjust the trim 

map then have the program make auto adjustments.  These 
auto adjustments will not be correct if you have already 

adjusted the Fuel Trim value manually. 
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7.4 Manual Mapping Correction 
If you do not want the program to make the changes in an automated fashion 

you can still use the recorded values to help tune. 

 
If Auto-Tune and Roll-On Mode are both disabled the values will be stored in the 

A/F tables but no corrections will be made to the trims. 
 

In the screen shot below you can see the recorded A/F values and the text is 
black to indicate that the value has not been corrected. 

 

  
 
 

To correct the map rows up to 19% throttle between 2800RPM and 3500RPM you 
need to select the area you want to correct.  Do this by clicking and dragging the 

mouse over the area to be selected as below: 
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Now click the C key on the keyboard.  This will calculate the trim required to bring 

the A/F ratio in line with the target and will update the fuel trim table with the 
required values. 

 
Once the changes are made to the Fuel Trim table the selected area in the Air 

Fuel Ratio table is changed to show the text in grey, indicating that the area has 

been corrected.   
 

On the following screen you can see the corrections that the program has 
calculated.  The changes will be sent to the ECU assuming that the program is 

connected to the motorcycle. The line at the bottom of the screen will show 
“Update Data” until the data has been fully sent to the ECU. 
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The new trims are sent to the ECU and you can now run the bike again and check 

the results.  You should not need to do more than two passes to correct the fuel 
mapping. 

 
The following screen shot shows the A/F table after two passes at each throttle 

point. 
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The next screen shows the final trim values: 
 

 
 

 
The next screen shot shows the A/F graph at the 19% throttle point: 

 

 
 

You can see the yellow and blue lines are now very close to the green target line. 
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8. ROLL-ON MODE TUNING 
 
The Roll-On Mode is provided to help automate the tuning process. 

 
To use this mode you must have an Innovate LC-2 wideband O2 controller 

connected to the O2 sensor input on the bike or connected to the Serial In on the 
WB-01 (Using cable sold separately). 

 
N.B.  If the LC-2 is connected to the Serial In on the WB-01 it is important that 

the LC-2 is powered on before the WB-01 or at the same time.  If the WB-01 is 

powered on before the LC-2 you will not see any A/F readings from the LC-2. 
 

If the LC-2 is connected to the O2 sensor plug on the motorcycle you should 
make sure the output of the LC-2 is set to the factory default output values and 

that the fuel type is set to “14.7/1 Gasoline”. Use the LM-Programmer software 
included with the LC-2 to check these settings. 

 
Any wide band O2 controller can be connected providing it can output the 0-5volt 

signal, just make sure it has 0v for 10/1 and 5v for 20/1 and that the O2 sensor 
type is set to Generic 0-5v on the target screen.. 

 
1. To enable the roll-on mode go to the “Options” menu and select “Roll-On”. 

This will display the target screen and put a marker (radio button) in “Roll-
On Mode” on the target screen. If you only have one wide band O2 sensor 

you should only have a tick on the target screen in the A/F display that the 

wide band is connected to (A/F Front or Rear). This will make sure the value 
from the second O2 sensor input is ignored. 

 
2. With this mode selected you should set the dyno to hold at the desired 

starting RPM then turn the throttle to the throttle row you want to tune.  
Use the target screen to get the throttle position as close to the horizontal 

line as you can. Once the throttle has been stable in the throttle zone for a 
number of samples the A/F value will be updated in the table. The number 

of samples can be adjusted in the Process Log File screen. 
 

3. Now release the hold on the dyno to let the revs increase.  It is best to use 
a slow ramp rate at low throttle and a faster rate at high throttle.  Hold the 

throttle steady until the revs climb as far as they can and then release the 
throttle. 

 

4. When you release the throttle the program will calculate the correction 
required and make the changes to the trim table.  These changes will get 

sent to the ECU as soon as they are made. 
 

NOTE: 
• For the first pass at a given throttle row the program will apply the full trim 

amount. 
• For the second pass at a given throttle row the program will again apply the 

full trim amount.   
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• For the third pass at the same throttle row the program will apply half the 
calculated correction value. 

• For any extra passes the program will step 0.5% in the direction required. 
 

This process prevents the “yo-yo effect” you can get with auto-tune options. 
 

Two passes at any throttle row should be enough to get the A/F values into the 
green zone.  

 
Roll-On mode can be used for on-road tuning.  If you do this it is important to try 

to ride the bike in a smooth way.  Avoid sudden throttle changes as this will make 

it hard for the software to match throttle points with the A/F readings.  The best 
way to tune on the road is to record a data log and make the adjustments by 

using the ‘C’ key after you have completed your test ride. 

 

9. LOADING THE TRIM FILE ONCE TUNING IS 

COMPLETE 

 
1. Go to the File menu and select “Reflash ECU”. The program will prompt you 

to save the trim file.  
 

2. Once the file is saved the TuneBoyTrim program will close and the 
FlashMitsubishi program will start. The FlashMitsubishi program will open 

the last tune flashed into the ECU and apply the trim file you have just 

saved.  
 

3. If you want to select a second or third trim map you can do this. 
 

4. Now click the “Re-flash ECU” button to load the changes into the ECU. 
 

5. Once the re-flash is completed you should start the trim program and check 
that the correct numbers are shown when the trim file is read from the ECU. 

 
 

10. REAL-TIME IGNITION MAP CHANGES 
 

CAUTION 
Adjusting ignition maps in real-time should only be done on 

a dyno by a trained dyno operator.  This should also only be 

done on a dyno that can show HP or torque while the dyno 
is holding a set RPM (most DynoJet® dyno’s are unable to 

do this). 
 

1. Start the TuneBoyTrim program and open the target screen (T). 
 

2. Turn on Auto-Tuning (click the Auto-Tune Enabled radio button on the 
target screen). This will make sure the A/F ratio is corrected as you adjust 

the ignition mapping. 
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3. Now select the “Ignition Trim” table. 
 

4. Set RPM to hold at one of the RPM points in the map and turn the throttle 
until the yellow dot is inside the green square.  If you hit the spacebar on 

the keyboard this will make the current edit cell follow the point shown in 
the target. 

5. Use the PageUp or PageDown to alter the ignition trim value and watch 
the HP reading on the dyno. 

 
6. Increase the ignition trim until the HP on the dyno stops increasing, and 

then reduce the ignition trim until you have the value that gives the best HP 

for the least ignition advance. 
 

While you are adjusting the ignition advance the TuneBoyTrim program will make 
sure the A/F ratio stays on target. 

 
Using this method to map ignition at lower throttle points can make big 

improvements to the throttle response and fuel economy of the motorcycle. 
Again, once the changes have been made the trim map must then be saved and 

loaded into the ECU using the FlashMitsubishi program. 

 

 

11. AUTO-THROTTLE FEATURE 
 

For dyno operators we have added the ability to control the throttle from the PC. 

To do this you set the dyno to hold RPM then click on the end throttle and RPM 
point in the map, for example 4500RPM and 20% throttle. 

 
Now hit the F5 key on the keyboard. 

 
The throttle on the motorcycle will go to 20% until the RPM reaches 4500 RPM, at 

this point the throttle will close. 
 

If you need to stop before the 4500 RPM hit the space bar on the keyboard.  This 
will instantly return the throttle to the closed position. 

 
The rate that the throttle opens is controlled by the “Throttle Speed” value on the 

Config Options screen. (see next screen shot) 
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A value of 1 will make the throttle open at a slow rate, a value of 30 will make it 

open very quickly. 

 
This allows accurate throttle control for dyno-tuning. 

 
N.B. On the Panigale and 2013 Multistrada the use of the F5 function will make 

the ECU switch to a linear throttle table.  This allows a one to one ratio between 
the throttle grip position and the butterfly position. 

When the linear throttle table is not active the butterfly position will change 
throughout the rev range even if the throttle grip is held at the same point. 

 
 

12. HIGH SPEED DATA-LOGGING 
 
1. To allow data-logging the bike must be running. 

 
2. Go to the “Tools” menu in the TuneBoyTrim software and select “Start 

Logging”. 

 
3. Create a file name and select “Save”.   

 
You can still make changes and use all normal functions in the program whilst 

data-logging.  
 

When you stop the TuneBoyTrim program it closes off the data-log file. 
 

The data-log file is in a raw data format so it can only be processed by the 
TuneBoyTrim program. 

 
The data-logging can be used to trim the bike after collecting data from a ride. 

 
When collecting data from a road ride you should try to avoid sudden throttle 

movements as these will cause the A/F ratio to change due to acceleration 
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enrichment (the throttle pump function of the ECU adds extra fuel for sudden 
throttle changes). 

 
N.B. You must make sure your laptop does not go into suspend mode when you 

close the lid.  This can be changed under the power options in the control panel of 
your laptop (Windows function). 

 

12.1  Processing a Log File 
1. Hit the ‘T’ key on the keyboard to display the target screen. If you only 

have one A/F sensor connected you should make sure you only have a tick next 
to the A/F number for the cylinder that had the sensor when you collected the log. 

 
The following screen shot shows the target screen if you have the A/F sensor 

connected to the front cylinder. 
 

 
 

2. Now go to the “Tools” menu and select “Process log file”.   
 

The following screen is displayed: 

 

 
 
3. Click the “Select file” button and select the log file you have created. 

 
4. Now click the “Process log file” button.  The software will process all the 

records in the file and fill in the A/F tables. 
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The following screen shot shows the A/F table for the front cylinder after 
processing the log file: 

 
 

5. Now with the A/F tables filled in you can select the areas that need 
correcting and hit the C key on the keyboard to correct the fuel trim table. 

 
Once you correct an area of the map the text colour in this area will change to 

grey.  This is shown in the next screen shot: 
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The next screen shot shows the trim table with the calculated trims: 
 

 
 

6. To reflash the ECU with this new trim table you go to the “File” menu and 
select “Reflash ECU”. You will be asked to save the trim file then the TuneBoyTrim 

program will close and the FlashMitsubishi program will start. 
 

7. Click the “Reflash ECU” button. 

 
Once this is complete you can record another log file to check the results of the 

changes. 
 

It is important that any changes made are applied to the trims that are in the 
bike at the time the log was recorded; if not, the corrections will be incorrect. 

 
By default the TuneBoyTrim program will open the last trim file that was saved. 

 
8. Once you are happy with the trims on one cylinder you can move the A/F 

sensor to the second cylinder and record a data log from the second cylinder. 
 

The “Process log” screen allows you to adjust the settings used to process the log 
file.  

 

12.2 Settings 
• The “Stable throttle for number of samples” tells the software how 

many records must be read with the throttle between the lower and upper 
green line in the target screen before A/F records are collected. This is used 

to make the software ignore any A/F values recorded when the throttle is 
opening or closing as these values will be richer or leaner that the steady 

state values.  If you adjust this number to a smaller number it will show 
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more values in the A/F table but the values may show leaner or richer than 
the actual A/F at steady throttle. 

• The “RPM and throttle zone %” controls the size of the green square in 
the target screen. If you make the number smaller you will only get values 

in the A/F table if the throttle and RPM are closer to the point in the table.  
Making this number bigger will fill in more of the A/F table but the numbers 

may be less accurate as they can be further from the actual point in the 
tables. 

• The “Update in real time” tick box will make the program show the 
values as they are processed. 

 

 

13. SERVICE INDICATOR RESET 

 
To clear the Oil Service indicator you need to go to the “Tools” menu and select 

“Reset Oil Service Indicator”.  This will clear the service indicator light from the 
dash. 

To clear the Desmo Service indicator you need to go to the “Tools” menu and 
select “Desmo Oil Service Indicator”.  This will clear the service indicator light 

from the dash. 
 

These options only work if you have a TuneBoy map loaded into the ECU.  It will 
not work on a standard Ducati map. 

 
 

14. THROTTLE RESET 

 
The throttle can be reset in two ways. 

 
The first type of reset is the APS reset. This resets the low point for the 

Accelerator Position Sensor. The APS is the throttle grip position sensor.  To clear 
the APS low point you need to go to the “Tools” menu and select “Reset 

Accelerator Position Sensor”.   
 

The second throttle reset function is the TPS Reset.  This resets the Throttle 
Position Sensor on the throttle body.  To clear the TPS low point you need to go 

to the “Tools” menu and select “Reset Throttle Position Sensor”.   
 

Use the APS and TPS reset functions if you have problems with the throttle action 

or high idle problems. 
 

15. CLEAR LEARNED AF TRIMS 
 
The learned AF values are the long term fuel trims that the ECU has made based 

on the O2 sensor readings.  If you have run the motorcycle with a faulty O2 
sensor these values can cause running issues. 

Using the “Clear Learned AF Trims” under the “Tools” menu will clear these values 
back to 0. 
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The TuneBoy Tuning and CruiseAndTuning maps disable the O2 sensors.  This 
means you should only need to do this once if you have one of our maps loaded. 

  

16. CRUISE CONTROL 
 

The Cruise Control feature adds full electronic cruise control to the ECU.  
 

In its most basic form this allows the start button to be used to turn on and set a 
cruise speed. 

 

• Cruise control cannot be activated until the motorcycle speed is 
over 30 kph. 

• Cruise control cannot be activated if the clutch is pulled in or the 
brakes applied. 

 
Once the cruise control is active the ECU will monitor the speed of the motorcycle 

and adjust the throttle to hold the speed that the motorcycle was doing at the 
time the cruise control was set. 

 
Cruise control will disengage under the following conditions: 

1. If the rider applies the front or rear brake (even minutely), 
2. If the clutch is pulled in, 

3. If the engine RPM goes past 6500RPM, (7500 for Panigale), 
4. If the throttle required to hold the set speed reaches 50% throttle. 

 

16.1 Activating Cruise Control 
To turn the cruise control on, start the motorcycle then hold the start button 

pushed-in for three seconds. This will turn the feature on and at the same time 
the throttle will give a small blip to indicate that the cruise control is on. 

N.B. The throttle ‘blip’ (audible indicator) will not be done if the clutch is pulled or 
brake applied. 

 
You can turn cruise control on while riding by holding the start button for three 

seconds.  

N.B. The throttle ‘blip’ (audible indicator) will not be done while the bike is 
moving but the cruise control will still be turned on. 

 
Once the cruise control is turned on you activate the cruise mode by pressing the 

start button (unless you have nudge buttons fitted). When you press the start 
button you will notice a slight change in throttle and the motorcycle will drop 

speed slightly before the ECU takes control. At this point you can roll-off the 
throttle completely and the bike will maintain speed by itself. 

 
Under most riding conditions the cruise control will maintain speed to within 2-

3kph of the set speed. 
 

If you need to overtake a slow vehicle you can apply throttle. This will override 
the cruise control and allow you to increase speed. Once you back the throttle off 

the cruise control will take over as soon as the speed drops back to the previously 

set cruise speed. 
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If you need to increase the set cruise speed you do not need to disengage; simply 

accelerate to the new speed and press the start button again. 
 

If you need to decrease speed simply touch the brakes then press the start 
button when the bike slows to the desired speed. 

 
If you have purchased a key for both tuning and cruise control you can fit the 

optional nudge buttons for the cruise control. These connect to the rear O2 sensor 
for the Multistrada and Diavel or the front O2 sensor for Panigale.  

 

Note: older versions of the TuneBoy maps used the front O2 plug for the nudge 
buttons on the Diavel, this has been changed to the rear O2 plug as the 

QuickShifter now uses the front O2 plug. 
 

The nudge buttons must be enabled.  This is done in the TuneBoyTrim program 
from the Config Options screen.  Go to the “Tools” menu and select “Config 

Options”.   
 

The following screen will be displayed: 
 

 
 

As long as you do not have a tick in the “Power O2” option the ECU will assume 
you have an LED connected between pin 3 and 4 on the O2 sensor plug. If you do 

have the LED fitted the LED will light up when cruise control is active and blink 
when you accelerate to overtake a car. 

 
The “Nudge buttons fitted” tick box tells the ECU that you have the buttons but 

do not want the resume function to be enabled. 
 

The “Nudge buttons with resume function” tells the ECU that you have nudge 
buttons fitted and you want the nudge down button to act as a resume button. 

If you have to brake to slow down you can press the nudge down button and the 

ECU will go back into cruise control and accelerate back to the previously set 
cruise speed.  
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The ECU will only accelerate at 3 kph (1.86 mph) per second for safety reasons. 

 
The “Use menu up and down for nudge” is for the Panigale only.  This allows the 

menu up and down buttons to be used to increase and decrease the cruise speed. 
 

The buttons allow the following extra function: 
• Cruise speed can be increased by pressing the up button, or decreased by 

pressing the down button (while cruise control is active). 
• If the cruise control is on but not active the nudge up button can be used to 

set the cruise. 

• If the resume function has been enabled, the nudge down button acts as a 
resume button.  The resume function only works if you have been using 

cruise control and had to brake or pull the clutch.  When the resume button 
is pushed the cruise will activate and the speed will increase at a rate of 

3kph (1.86 mph) per second until the previous cruise speed is reached.  If 
you need to accelerate to a new speed you can accelerate without turning 

the cruise off and by pressing the nudge up button the system will set a 
new cruise speed. 

 
On the Panigale the menu buttons can be used to increase and decrease speed.   

These buttons cannot be used to set the cruise speed.  They can only be used for 
adjusting speed.  The normal function of these buttons still takes place, this is 

controlled by the dash and we have no way of disabling this. 
 

If you have the nudge buttons selected the start button is only used to turn cruise 

on.  It no longer acts as a set button. 
 

16.2 Heated Grips 
If you have the heated grips on a Multistrada 1200 these will function as normal.  

 
N.B. The cruise function may take over if the bike speed is over 40kph. 

To prevent the cruise control taking over while adjusting the heated 

grips we recommend pulling the clutch in while you adjust the heated 
grip settings.  

 
The cruise control will not be activated if the clutch is pulled in. 

 
If you have the nudge buttons fitted the start button is only used to turn the 

cruise control on, after this the start button acts as it always did. 

 
16.3 Cruise Control PreFlight Check 
Before riding with cruise control you will need to run the CruisePreFlight.exe.  
This displays the clutch switch flag and brake switch flag. Pull the clutch in and 

apply front and rear brakes to ensure that these flags change from 1-0 or 0-1 as 
indicated on the screen.  You will see a 1 or 0 displayed on this screen: 
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17. QUICK SHIFTER 
 

The Quick-Shifter option allows you to fit a strain-gauge Quick-Shifter to the 
MTS1200, Diavel or Panigale.  

 
A strain-gauge quick-shifter outputs a voltage based on the amount of pressure 

applied to the shift lever. With no pressure the output of the quick-shifter is 2.5 
volts. As pressure is applied to the shift lever the output voltage will increase or 

decrease.  As the Quick-Shifter comes under compression the voltage will 

increase and as the Quick-Shifter comes under tension the output voltage will 
decrease.  The range of pressure sensing is +/- 30kg. 

 
The output of the Quick-Shifter is connected to the O2 sensor input on the 

motorcycle; this allows the TuneBoy program in the ECU to monitor the shift lever 
pressure. 

 
When the pressure on the shifter reaches the trigger point (set in the config. 

options) the ECU will either kill power (for up-shifts) or blip the throttle (for down 
shifts).  This allows the rider to change up through the gearbox without needing 

to use the clutch or back off the throttle, it also allows the rider to shift down 
through the gearbox without needing to use the clutch or throttle blip. 

 

17.1 What is Auto-Blip? 
The Auto-Blip is a feature that has been used on MotoGP bikes for a number of 

years. It allows the rider to change down through the gearbox without touching 
the clutch and without having to ‘blip’ the throttle.   

 
This can only work if the ECU can detect the down shift pressure on the gear lever.  

This is why a strain-gauge type quick-shifter is required.  When the ECU detects 
that the rider has pushed down on the lever the ECU gives the electronic throttle 

a small blip.  The blip amount and duration will vary based on RPM and gear as 

the ECU needs to give a big enough throttle blip to unload the gearbox (this 
means bringing the engine output up to a point where it matches the back torque 

being applied by the force of the motorcycle slowing down).  The normal way that 
the rider would unload the gearbox is to pull the clutch in.   With the auto-blip 

this is not required as the blip removes the load on the gearbox and allows the 
gear change with less force than you would require with the clutch pulled in. 

The auto-blip does not only blip the throttle for the gear change, it also holds the 
throttle slightly open after the down-shift. This small throttle opening is used to 

stop the rear wheel locking up due to the down-shift.  This allows the engine to 
come up to speed before the throttle returns to the fully closed point. 

This after-blip throttle hold can be used to reduce the engine brake effect; this is 
like the EBC function included in the Panigale. 
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See the info on the Blip and TPH tables for details on the table values. 

 

17.2 Quick-Shift Option 
Before the strain-gauge Quick-Shifter will work you must enable it in the Config 

Options (under Tools in TuneBoy Trim program).  This is done by adding a tick to 
the Quick-Shift tick box. 

 
N.B. If your motorcycle is a Panigale you should only tick this box if you have the 

strain-gauge shifter fitted, not the factory shifter. 
 

17.3 Blip and Kill Pressure Setting 
Setting the pressure for up and down shifting is done in the Config Options screen 
(see screen shot below): 

 

  
 

Moving the Blip Pressure slider to the left will set a lower pressure to trigger the 
down-shift blip.  Moving to the right will set a higher pressure.  If you move the 

slider fully to the left it will disable the down-shift auto blip function. 

 
You should start with a soft pressure for the blip and kill pressures and only 

increase the pressure if you have problems with the shift action. 
 

The code in the ECU will increase the kill pressure if you are shifting at higher 
throttle.  This increase is 5kg more at full throttle.  This allows a light shift action 

at low throttle while requiring a firmer action at higher engine loads. This helps 
prevent false neutrals on up-shifts. 

 
The blip pressure is also increased by the program in the ECU but this is done 

based on RPM.  The light pressure point is required for smooth down-shifts at low 
RPM, but a higher pressure is required for good down-shifts at higher RPM. 

 
These pressure modifiers are a new feature in the V4 TuneBoy maps. 
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If you have changed your motorcycle to use a race-shift pattern (up for lower 
gear and down for higher gear) you should put a tick in the “Reverse Shift (Race 

Pattern)” tick box. This reverses the pressure points inside the ECU. 
 

17.4 Adjusting the Quick Shifter Kill Time 
The “QS Kill Time” slider allows you to adjust the kill time used for up-shifts. If 
the slider is fully to the right, the kill time will use the default time. 

As you move the slider to the left the kill time will be reduced. 
 

N.B. If your motorcycle is a Panigale this time adjust can be used to adjust the 
kill-time for the factory fitted shifter. 

 

17.5 Kill Ignition on Up-Shift 
If you have a tick in this option the ECU will kill ignition during the up-shift. This 

will result in a ‘pop’ from the exhaust as any unburnt fuel will build up in the 
exhaust pipe. Having a tick in this option should provide a better up-shift power 

kill. 
This may create a loud pop on up-shifts if you have a very open exhaust.  You 

can use this option at your discretion. The up-shift kill will still work if this option 
is un-ticked. 

 
This option does nothing on the Panigale; it is only for the Multistrada and Diavel. 

 

18. SHIFT-LIGHT 
 

The TuneBoy V4 maps have support for an external shift-light. This allows you to 

fit a bright shift-light. These will become available on the TuneBoy website soon. 
 

The shift-light function turns on the O2 heater circuit on the O2 sensor plug used 
for the Quick-Shifter.  The O2 sensor plug has 12v on pin 3 and the O2 heater 

ground is pin 4.  The TuneBoy QuickShifter does not have anything connected to 
pin 4 on the QuickShifter plug.  Connect the + of the Shift light to pin 3 and the – 

of the shift light to pin 4.  The pin numbers are marked on O2 sensor plug. 
 

We will soon provide a program to adjust the turn on points for the shift light. 
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19. MAP SWITCH FUNCTION 
 
The TuneBoy V4 maps can have up to three trim maps that the rider can switch 

between.  For example you could create a trim map for open silencers and one for 
silencers with DB Killers fitted.  The FlashMitsubishi program can load both these 

trim maps into the ECU. 
 

Once the ECU has been reflashed the rider can select the trim that they want to 
use by following the steps listed below: 

1. Turn the ignition on but don’t start the motor, 

2. Turn the throttle to the fully open position, the rev counter will show 5000 
RPM, 7500 RPM or 10000RPM to indicate which trim map is currently 

selected, 
3. Continue to hold full throttle and pull clutch in then release. The RPM will 

show 5000, 7500 or 10000 to show which map the ECU has switched to, 
4. Repeat this process to switch to the next trim map. 

 
If you have loaded two trim maps the RPM will cycle between 5000 and 7500 to 

indicate map 1 or map 2. 
 

If you have loaded three trim maps the RPM will cycle between 5000, 7500 and 
10000 to indicate map 1, 2 or 3. 

 
If you have only loaded one trim map the map switch function is disabled. 

 

By loading multiple trim maps you can easily compare two different trim files to 
work out the one that is best for your motorcycle. 
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20. LOGWORKS MOBILE 
 
The latest TuneBoy maps have code added to allow the Innovate LogWorks Mobile 

iPhone/iPad app to be used with your motorcycle. 
Do a search for “LogWorks Mobile” on the app store and download the free app. 

Run the LM-Programmer and set the protocol as shown in the following screen 
shot. 

 

 
 

Once this option is set you should be able to run the LogWorks app on the iPhone.  

The LogWorks app allows you to show info from the ECU and many other useful 
features. 
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21. LIST OF KEYBOARD COMMANDS 
 
A  Turns Auto-Tune mode on. Target screen must be displayed. 

 
C Corrects the selected area of the Air Fuel Ratio table.  A/F Ratio table 

must be selected. 
 

G  Displays A/F Graph screen. 
 

R  Turns Roll-On-Mode on or off. Target screen must be displayed. 

 
T  Shows the target screen. 

 
Z  Zeroes (clears) the selected area of the current table. On the A/F 

table you may need to hit the ‘Z’ key twice to fully clear the values. 
 

Ctrl-S Saves the trim map. The date and time are added to the file name 
automatically.  This is a good way to make a save point that is easy 

to go back to. 
 

SpaceBar This will make the green edit square follow the current TP and RPM. 
Hit the SpaceBar again to turn this function off.  

 
The SpaceBar will also turn off the auto throttle function when this 

is used on the dyno. 

 
F5 Drives the throttle to a point in the map.  This is used by clicking 

on a cell in the map and pressing the F5 key.  The throttle will move 
to the throttle row until the selected RPM is reached. 

 
Ctrl-F5 Sets the lowest throttle to use (for dyno use). This prevents the 

bike dropping back down to idle when the operator is otherwise 
occupied. 
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APPENDIX A: 
 
 

TuneBoy Advance WiFi Kit Components for Mitsubishi 

or Magneti Marelli (5AM/59M ECU) 

 
 
 

 

 
 

 

 
 

N.B. Both Ducati adapters are not included in your kit.  Only the adapter you 
selected for your kit is provided.   

 
Other adapter options are available for Aprilia (Sagem only), KTM (Keihin), Benelli 

(Sagem only). 
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APPENDIX B: 

 

LC-2 Kit Components 
 

 
 

 
 

 

 


